CalPlanning | Job Aid Enter Data into Intersection Forms
Updated 2/10/15

Overview

Introduction
The Intersection Form is a CalPlanning data form that finds the lowest level intersection of chart of accounts values
where your data is populated. The intersection is the level at which you can change CalPlan data. You can use the
Intersection Form to modify existing data. A new feature as of the February 2, 2015 release is the ability to add a new
intersection row of data into the Intersection Form.

There are now two intersection forms with the same functionality, but the chart of accounts are ordered differently to
provide two different views of your data. The original Intersection Form was sorted by Entity first, and the newly added
Intersection Form is sorted by Account first. The two forms display the same information in a different sort order to
allow for easier and more thorough data analysis. Which form is being utilized is based solely on user preference, as the
intersection forms are designed to help users with their planning. Users are not required to use the forms if they do not
wish to do so.

Planners are now able both modify data and add rows of data directly in the following Intersection Form tabs:
1. Revenue
2. Transfers
3. Non-Comp Expense
4. Changesin Fund Balance

This document explains two ways that you can enter data into Intersection Forms: A) using CalPlan and B) using Smart
View.

Note: As a reminder, Compensation expenses continue to be read-only in these CalPlan forms since compensation
data is planned in HCP.

Content Overview
e Navigate to the Intersection Forms
e Enter data into the Intersection Forms using CalPlan
e Add anintersection row directly into the Intersection Forms
e Enter data into the Intersection Forms using Smart View
e Add an intersection row directly into the Intersection Forms using Smart View

Security Access
CalPlanning users with a Planner role will have access to change CalPlan data.

Questions
If you have any questions, please email calplanhelp@berkeley.edu.
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Navigating to the Intersection Forms

Intersection Form by Entity

1. Loginto CalPlanning and navigate to your CalPlan Task Lists

Enter Data into Intersection Forms

2. Navigate to the Intersection Form by Entity using the following Menu Path: CalPlan FY15 Forecast Task List >

Enter Data > Edit Intersection Form by Entity

My Task List

P Reference Tools
P HCP Planner Task List
= [ CalPlan FY15 Forecast Task List
e CalPlanning Forecast Approach
o Check that Planning Preferences are Set
P Prepars
= EJ Enter Data
&9 Frter Data in Form
E;-.'|E|itlntemctinn Form by Entity |

1 EW Cfit Tk mcbie B boe Bk

Intersection Form by Account

Task - Edit Int
=
& MyOre

Intersection |

1 10187 - BAH:
1 10650 - BAH:

1 10651 - BAH:
1 10208 - BAH:

1. Loginto CalPlanning and navigate to your CalPlan Task Lists

2. Navigate to the Intersection Form by Account using the following Menu Path: CalPlan FY15 Forecast Task List >

Enter Data > Edit Intersection Form by Account

|I'~"I'y|r Task List

P Reference Tools

P HCP Planner Task: List

B[ calplan Fy15 Forecast Task List
e CalPlanning Forecast Approach
o Check that Planning Preferences are Set
P Frepara

= P Enter Data
& Enter Data in Form
S Edit Intersection Form by Entity

g'|E|it Intersection Form by Account

=i T L = [,
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Enter Data into Intersection Forms

Enter Data into the Intersection Form Using CalPlan

Follow the steps below to enter data into the Intersection Forms using CalPlan.

1. Loginto CalPlan and navigate to the Run Intersection Form task list using the menu path referenced above.
CalPlan FY15 Forecast Task List > Enter Data > Edit Intersection Form by Entity or
CalPlan FY15 Forecast Task List > Enter Data > Edit Intersection Form by Account

Note: Just like any of the other CalPlan forms, planners can only enter data into white cells:

[ ion Form - \Intersection Form - Transfers

YearTotal

1 10187 - BAHSE Devel Alumni Relati sales and Services Other Revenue - Plan C1 - Summary - Plan | 463X - Sales Services & Other Income - Flan | 0
1 10373 - BAHSE B&O Haas Gear 66350 - Generic Revenue-Other Sources C1 - Summary - Plan | 483X - Other Income - Plan (22)
sales and Services Other Revenue - Plan C1 - Summary - Plan | 463X - Sales Services & Other Income - Plan 21,855

1_10375 - BAHSB B&O Cafe sales and Services Educational - Plan C1 - Summary - Plan | 463X - Sales Services & Other Income - Plan 42,393
1_10464 - BAHSB Exec Ed Custom 60351 - Center for Exec Education C1 - Summary - Plan | 435XX - Nonoperating Rev/Exp-Other - Plan 1,200,000
1_10652 - BAHSB Student Aid PhD Restricted Gifts - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 133,792
1_10653 - BAHSB Student Aid Undergrad | Restricted Gifts - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 48,740
Restricted F {ation Endowments - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 115,016

1_10654 - BAHSB Student Aid General Restricted Gifts - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 50,000
Restricted F lation Endowments - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 3,976

Restricted F lation FFE - Plan C1 - Summary - Plan | 4403X - Private Gifts for Current Use - Plan 483

1_10208 - BAHSE Berk Innov Ldr Dev-BILD | Restrictad Gifts - Plan C1 - Summary - Plan | 440XX - Private Gifts for Current Use - Plan 45,000
1_10314 - BAHSB Instr MFE Gen Ops 60344 - HAAS: CTR FOR EXEC DEVELOPMENT | C1 - Summary - Plan | 404XX - 55 and Spedial Programs Rev - Plan 139,500
Restricted Gifts - Plan C1 - summary - Plan | 440X - Private Gifts for Current Use - Plan 9,750

Restricted Foundation Endowments - Plan C1 - summary - Plan | 440XX - Private Gifts for Current Use - Plan 13,000

Note: the Comp Expense Intersection Form is grayed out, because the form is read-only

| Intersection Form - Revenue { Intersection Form - Transfers | Intersection Form - Non-Comp Expense"". Intersection Form - Changes in Fund Bi

YearTotal

1_10534 - BAHSBE Acad Faculty Gen Ops 20150 - EVENING MBA-HAAS FEE C1 - Summary - Plan | 50210 - Faculty 2,680,570
53010 - Faculty Benefits 699,629

57310 - General & Empl Liability Insur 22,785

20151 - MFE Degree Fes C1 - Summary - Plan | 50240 - Acad Teach-Regular (Default) 401,077

53030 - Other Academics Benefits 67,782

57310 - General & Empl Liability Insur 3,409

20231 - PD Supp Tuition - Bus Adm/Mgmt | C1 - Summary - Plan | 50210 - Faculty 555,000

53010 - Faculty Benefits 144,855

57310 - General & Empl Liability Insur 4,718

19900 - GENERAL FUNDS C1 - Summary - Plan | 50210 - Faculty 13,548,257

53010 - Faculty Benefits 3,536,085

57310 - General & Empl Liability Insur 115,160

1_10372 - BAHSE B&O Fac Assists 19900 - GENERAL FUNDS C1 - Summary - Plan | 51210 - Staff-Non student 572,279
520X - Other Employes Compensation - Plan 0

53020 - Staff Non student Benefits 229,484

57310 - General & Empl Liability Insur 4,864

2. Select the data to update.
a. Example: Update 1_10654 > Restricted Regents FFE - Plan from 2,664 to 5,000 in the Transfers form.

Before

" Intersection Form - Revenue ” tion Form - Transfe ‘Llntersection Form - Comp EXPEI'ISEE\-‘:" Intersection Form - Non-Comp Expense Intersection Form - Ct

YearTotal
4,073

1_10654 - BAHSB Student Aid General Restricted Regents Endowments - Plan

Restricted Regents FFE - Plan

C1 - Summary - Plan | 72210 - Regents Endow/FFE Payout
C1 - Summary - Plan | 72210 - Regents Endow/FFE Payout I
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After

Intersection Form - Revenue |[ Intersection Form -Tmrsfas\LIntersecﬁon Form - Comp Expense Intersection Form - Non-Comp Expense Intersection For

YearTotal

1 10654 - BAHSB Student Aid General Restricted Regents Endowments - Plan C1 - Summary - Plan | 72210 - Regents Endow/FFE Payout L
Restricted Regents FFE - Plan C1 - Summary - Plan | 72210 - Regents Endow,FFE Payout | 5,000

3. Click Save.

Mavigaie File Edit View Favoritez Toolz  Administration Help

A B s * Emlnralﬁ D E | S H =

I
r Yo

[
HomePage = v O e S Tyl CalPlan - Task List

[+ HOrms Task List Status

Manage Task Lists [ Task - Run Intersection Form-Intersection Form - Tabs . Task Instructions
M Tack 1ick [

Two things happen when you click on the Save button:

1. Datais saved to the CalPlan database.
2. The AggEntity business rule is run for the MyOrg variable

AggEntity in Progress...

Users will get a pop up message after clicking on the Save button:

(i) Information [ |

Messages for this page are listed
below.

(i) The data has been saved.

I:D Rule was run successfully

=T

4. Click OK button.

This is the final step for completing this activity using CalPlan.
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Add an Intersection Row into the Intersection Forms Using CalPlan
Follow the steps below to add a row of data into the Intersection Form in CalPlan.

1. Navigate to either of the two intersection forms:
a. Edit Intersection Form by Entity or
b. Edit Intersection Form by Account

IEI P CalPlan FY15 Forecast Task List
i CalPlanning Forecast Approach
G Check that Planning Preferences are Set
P Prepars
= Enter Data

[l S Enter DNata in Eorm
fo Edit Intersection Form by Entity
E’ Edit Intersection Form by Account

2. Right-click anywhere in the form to add a new intersection row
Task List Status

[ Task - Edit Intersection Form by Entity-Intersection Form by Entity . Task Instructions

=]
i MyOrg: 1_BOALT \J); Current Scenario: Forecast ;) Current Stage: Working ;) Current Year of View: FY15

Intersection Form by Entity - Revenue | Intersection Form by Entity - Transfers | Intersection Form by Entity - Comp Expense | Intersection Form by Entity - Non-Comp Expense

YearTotal

1_11865 - CLLAW DN Allocations | Unrestricted - Plan C1 - Summary - Plan | 4053X - Professional Degree Fees - Plan 29,103,260

; =gree Program - Plan [ 13,095,755

q_| Add Intersection by Revenue 265,750

Edit ¥ urrent Use - Flan 6,500

Adjust » Bther Income - Plan 2,152,500

Restricted Gifts - Plan C1 - Sur rrent Use - Plan 4,730,250

- B Comments

Restricted Endowments and FFEs - Plan | C1 - Sur] rrent Use - Plan 1,471,557

Contracts and Grants - Plan C1 - Sur 'E Supporting Detail Grants - Plan 2,997,488

PR chow Channe Histons jther Income - Flan 4750

Note: Each tab of the intersection form is broken out by Account type. The business rule for each tab is
specific to the tab’s associated Account type.
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3. The Runtime Prompt will be pre-populated with the members from the form, which need to be updated
as necessary. Be sure to select the lowest level members in each field. Otherwise, the business rule will
not create a new intersection.

Runtime Prompts - AddIntersection-Revenue T
Prompt Text Value
_-.*‘ * Gelact the lowest level Fund (e.g. 19900) "Unrestricted_Plan” ER
o * Selact the lowest level Revenue Account (eg. 41010) "£4053%_Plan" L
_‘-+ * Selact lowest level Chartl (eg. C1_SUMPLN) "C1_SUMPLN™ LE
.F * Select the lowest level Dept 1D (eg. 1_11871) "1_11865" L
Launch | Cancel

If the fields are not updated, and the “Add Intersection Business Rule” is launched, then a new intersection
row will not be added. This is because the combination of Fund, Account, Chart1, and DeptID members
already exist with dollar amounts in the form. A unique combination of members is required in order to add
a new intersection row.

4. Once a unique combination of lowest level members is selected, click Launch.

| Launch

5. Once the business rule is launched, a confirmation message will appear. Click OK.
The business rule confirmation is dependent on the Account on which the rule is run.

[@ Information Bl
AddIntersection-Revenus was
successful.

[ oK
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6. The Intersection form will now have a new row with $SO.
| Task - Edit Intersection Form by Entity-Intersection Form by Entity . Task Instructions

=

@y MyOrg: 1_BOALT ) Current Scenario: Forecast i Current Stage: Working o]
| Intersection Form by Entity - Revenue . Intersection Form by Entity - Transfers | Intersection Form by Entity - Comp Expense | Intersaction Form by €

YearTotal

1_11865 - CLLAW DN Allocations | Unrestricted - Plan C1 - Summary - Plan | 41010 - State General Support 0

4053X - Professional Degres Fees - Plan 128,103,260

4055 - Self-supporting Degres Program - Plan | 13,095,755

4056X - Other Fees - Plan 265,750

4400 - Private Gifts for Current Use - Plan 5,500

4800 - Sales Services & Other Income - Plan 2,152,500

Restricted Gifts - Plan C1 - Summary - Plan | 4400 - Private Gifts for Current Use - Plan 4,730,250

Restricted Endowments and FFEs - Plan | C1 - Summary - Plan | 4400 - Private Gifts for Current Use - Plan 1,471,557

Contracts and Grants - Flan C1 - Summary - Plan | 441X - Private Contract & Grants - Plan 2,997,488

46X0(K - Sales Services & Other Income - Plan 4,750

7. Change the SO to the correct dollar amount and click Save.

8. The AggEntity Business Rule will run and a confirmation message will appear. Click OK.

CD Information £l

Messages for this page are listed
below.

(i) The data has been saved.

@ Rule was run successfully

You have successfully added a row into an Intersection Form using CalPlan.

Berkeley Jpage

UNIVERSITY OF CALIFORNIA



CalPlanning | Job Aid

Enter Data into the Intersection Form Using Smart View

Follow the steps below to enter data into the Intersection Forms using Smart View.

Menu Path: Use the following menu path in Excel: Smart View > Panel > Shared Connections

Enter Data into Intersection Forms

=] = Bookl el o B %R
ie Home Insert Page Layout Formulas Data Review View Developer @ e = @ 2
S O= 92 Help -
= : ) ) g= FHep

b 1 Redo | ) Paste Data Poin @}@ @ 0= & sheetinfo
Panel Conne'ct\ons @ TR Refiesh s;}:gur Options E. ey

Start Edit Data General

a1 T

A B & D E F G H I ] K £ ; Smart View - X
2 Smart View Home @ - »
2 +5 Shared Connections
4 Connections from shared repository
5
P " Private Connections

Locally defined connections and shortcuts to

7 shared connections
2

1. Enter User Name and Password. Click Connect.

f — —

Connect to Data Source | 7 || &3
'-‘E User Authentication Needed.
=] .
Enter comect usemame and password to sign on.
Liser Name: =]
Password: T LI
Connect ] [ Cancel ] [ Details <=
(h 1] ke HiralnlmorndmartsloAas? harlalsse adiibuonrbensqa .l'l:nl

2. Click on the drop down menu arrow, to the right of the box that reads “Select Server to proceed”. Select

Oracle Hyperion Planning, Fusion Edition option in Shared Connections:

Smart View * )
Shared Connections fa - »
Select Server to proceed =+ -

| Orade® Hyperion Planning, Fusion Edition |
EpOring and ANaTysiE FTamenore
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3. Expand HYPP-PAOG6 > CalPlan > Task Lists
4. Navigate to the CalPlan FY15 Forecast Task List

Shared Connections T

Orade® Hyperion Planning, Fusion Edition -

== HYPP-PADS |
= CalPlan
H-[f1 Forme
=[] Task Lists
L CalPlan Ff 15 Forecast Task List
--[E] calPlan FY 15 Operating Budget Task List
Campus Budget Office Task List
HCP Planner Task List
L Reference Tools

5. Right click on CalPlan FY15 Forecast Task List and click on Open Task List.
Elﬁ Task Lists

24 1= | CalPlan FY 15 Forecast Task |ist '
=] CalPlan FY15 Operatir| | Open Task List

£ T

D@D

6. Once the Task List is open, navigate to the Edit Intersection Form by Entity or Edit Intersection Form by
Account task list that is located under 4.0 Enter Data:

CalPlan FY 15 Forecast Task List

- () 1.0 CalPlanning Forecast Approach
- () 2.0 Chedk that Planning Preferences are Set
[+#- () 3.0 Prepare

=- O 4.0 Enter Data

Diatein Eorm

4,2 Edit Intersection Form by Entity;

4, 3 Edit Intersection Form by Account

7. Right click on the Task List and click on Open Form, or double-click on the form.

<L S LENTEr LAata in rorm

N®¥4. ? Edit Intersection Form by Enti

(2 4.3 Edit Intersection Fory Piscannect
-2 4.4 Adjust Internal Oper
(2 4.5 Run Business Rule to
5.0 Review Reports Refresh Task List

Task Filter r

Mark Complete

Create Report
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Enter Data into Intersection Forms

8. Select the data to update and update the data in the cell.

The previous example for CalPlan showed how to update_10654 > Restricted Regents FFE - Plan from 2,664 to 5,000.
This example shows how to update the same intersection from 5,000 to 6,000, using Smart View.

Before

B @

Analyze | Refresh

& Lock
B caleulate =
Data

Ad Hoo

B2} Cell Actions ~ (5 Adjust ~
Sy, Drillthrough
BB submit Data

Bl More ~  §F Approvals

=3 Copy Version

Workflow

POV Intersection Form - Tabs - hypp-qal6_CalPlan_2

MyOrg:1_HAAS3 ] [ Current Scenario:Forecast ] [ Current Stage:Working ] [ Current Year of View:FY14 ] [ Refresh ]

u13 - J= | 5000
A B C D U Vi

10 1 10653 - BAHSB Student Aid Undergrad Restr?cted Regents Endowments - Plan C1-Summary- Plan 72210 - Regents Endow/FFE Payout 2964

1 Restricted Regents FFE - Plan C1-Summary- Plan 72210 - Regents Endow/FFE Payout 15036
12 1 10654 - BAHSB Student Aid General Restricted Regents Endowments - Plan C1- Summary- Plan 72210 - Regents Endow/FFE Payout 4073 /
13| — Restricted Regents FFE - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout I SOODI
14 71110- G I Allocati 499524

1_10206 - BAHSB ACAF Gen Ops 19500 - GENERAL FUNDS C1- Summary - Plan S e e
15 Transfers Offset - Divinternal - Plan -499524
16 71110 - General Allacation 118367
After

110653 - BAHSB Student Aid Undergrad Restricted Regents Endowments - Plan C1- Summary - Plan 72210 - Regents Endow)/FFE Payout 2964

- Restricted Regents FFE - Plan C1-Summary - Plan 72210 - Regents Endow/FFE Payout 15036

. . . _ ~ A0

1 10654 - BAHSB Student Aid General Restricted Regents Endowments - Plan C1-Summary - Plan 72210 - Regents Endow)/FFE Payout

- Restricted Regents FFE - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout

71110 - General Allocation 499524

1 10206 - BAHSR ACAF Gen (ns

19900 - GFNFRAI FLINDS

C1- Summarv - Plan

After entering 6,000 you will notice a color change on the cell, which means that the data has been entered into the form

but not been saved yet.

9. Click Submit Data button

|E| H l= Book3 - Microsoft Excel
Home Insert Page Layout Formulas Data Review View Developer Smart View Planning Acrobat

@ @)@ | B cent Actions ~ 53 Adjust ~ E More - §E Approvals

e & Lock S, Drill-through ZE) Copy Version

Analyze | Refresh POV |

Ad Hoc ] Workflow

POV Intersection Form - Tabs - hypp-qa06_CalPlan_2

[MyOrg:lﬁHMSS || Current Scenario:Forecast ] [ Current Stage:Working ” Curranh@r of View:FY 14 H Refresh |

5
U4 v fe | 499524 \
A B c D [ v | v

10 110653 - BAHSB Student Aid Undergrad Restricted Regents Endowments - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 2964
a5 Restricted Regents FFE - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 15036
12 e T e | Restricted Regents Endowments - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 4073
13- [ Restricted Regents FFE - Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 6000
{?l 1_10206 - BAHSB ACAF Gen Ops 19900 - GENERAL FUNDS C1- Summary - Plan @ UL Senold 8lioaiion :::Z;4l
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CalPlanning | Job Aid Enter Data into Intersection Forms

Unlike CalPlan, there is no confirmation pop up that the data is saved and the AggEntity business rule is run successfully.
If the data has been saved and the AggEntity business rule is run successfully, the color of the cell should be the same as
the rest of the data values.

1 10653 - BAHSB Student Aid Undergrad Restr?cted Regents Endowments - Plan C1- Summary - Plan 72210 - Regents Endow,/FFE Payout 2964
Restricted Regents FFE- Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 15036

R T lr—" Restricted Regents Endowments - Plan C1- Summary - Plan 72210 - Regents Endow,/FFE Payout 4073
- Restricted Regents FFE- Plan C1- Summary - Plan 72210 - Regents Endow/FFE Payout 6000
1 10206 - RAHSR ACAF Gen (Ins 19900 - GFNFRAI FIINDS 1 - Summarv - Plan 7l gl allfEe i 52

To confirm that the data has been saved and the AggEntity business rule has run successfully, click on the Refresh button.

\1—-“ H9- T = Book3 - Microsoft Excel
Home Insert Page Layout Formulas Data Review View Developer Smart View Planning Acrobat
-] @ | l'-g‘;‘_; Cell Actions ~ [5&3 Adjust = E more v B _']‘ Approvals
U Ol D Lock ® Drill-through =% Copy Version
Analyze] Refresh POV |
- M calculate B} submit Data
Ad Hoo Data Workflow

POV Intersection Forry- Tabs - hypp-qal6_CalPlan_2
MyOrg: 1 HAAS3 | ‘ Currht Scenario:Forecast ] [ Current Stage:Working ” Current Year of View:FY 14 ‘ | Refresh |
5

W22 \ I |

N

A B Cc D u

10 .1 10653 - BAHSE Student Aid Undergrad Restricted Regents Endowments - Plan C1-Summary - Plan 72210- Regents Endow,/FFE Payout 2964
| Restricted Regents FFE- Plan C1-Summary- Plan 72210 - Regents Endow/FFE Payout 15036

You have successfully edited data in an Intersection Form using Smart View.
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Add an Intersection Row into Intersection Form Using Smart View
Follow the steps below to enter data into the Intersection Forms using Smart View.

Menu Path: Use the following menu path in Excel: Click on Smart View > Panel > Shared Connections

&= R Bookl - M Excel o BN
File Home  Insert  Pagelayout  Formulas  Data  Review  View  Developer Acrobat a@ o =
=i - 1) Undo Copy Data Po @ @ di 2 Help ~

¥ —
s il Redo | [ Paste Data Point U= &% sheet Info
panel |Connections Refresh  Submit | Options
% (=] Functions = E: bl Bl More ~
Start Edit Data General
Al i Fe
A B s D E F G H 1 i K & M N o : Smart View v X

1

S Smart View Home @ - »

)

5 Shared Connections

a Connections from shared repository

5

;5 B Private Connections

Locally defined connections and shortcuts to

i shared connections

2

1. Enter User Name and Password. Click Connect

-

Connect to Data Source | T || £3 |

;-Er'f User Authentication Needed.
Enter comect usemame and password to sign on.

Liser Name: MSEVinC
Password: Tl
Connect ] [ Cancel ] [ Details <=
o httre Healnlnormtmaraloa? harlala ad hanrlonses o)

2. Click on the drop down menu arrow, to the right of the box that reads “Select Server to proceed”. Select Oracle
Hyperion Planning, Fusion Edition option in Shared Connections:

Smart View 2
Shared Connections - »
Select Server to proceed + -
Orade® Hyperion Planning, Fusion Edition |
Heporting and ANalysis Framework

UNIVERSITY OF CALIFORNIA
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3. Expand HYPP-PAO6 > CalPlan > Task Lists
4. Navigate to the CalPlan FY15 Forecast Task List

5. Right click on CalPlan FY15 Forecast Task List and click on Open Task List.

Shared Connections

Oracle® Hyperion Planning, Fusion Edition

=2 HYPP-PADS |
=@ CalPlan
[ Forms

=~ [ Task Lists

----- CalPlan FY 15 Forecast Task List
s

----- Campus Budget Office Task List
----- HCP Planner Task List

- Reference Tools

[Z] CalPlan FY15 Operati [ 5 Open Task List
(=

- 1 o

CalPlan FY 15 Operating Budget Task List

Enter Data into Intersection Forms

Once the Task List is opened, navigate to the Edit Intersection Form by Entity or Edit Intersection Form by

Account task list that is located under 4.0 Enter Data:

CalPlan FY 15 Forecast Task List

E

E

-2 1.0 CalPlanning Forecast Approach

- () 2.0 Check that Planning Preferences are Set
/- () 3.0 Prepare

- O 4.0 Enter Data

Diatain Eorm

4. 2 Edit Intersection Form by Entity’
4.3 Edit Intersection Form by Account

Berkeley
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Enter Data into Intersection Forms

6. Right click on the task list and click on Open Form, or double-click on the form.

- 4 L ENTEr Lata In Form

@R ? Edit Intersection Form by Enti

-3 4.3 Edit Intersection Form

Disconnect
-2 4.4 Adjust Internal Oper c R
- reate Report
-2 4.5 Run Business Rule to P
5.0 Review Reports Refresh Task List
Task Filter [
Mark Complete
7. The form will open in Smart View.
POV Intersection Form by Entity - HYPP-PADG_CalPlan_1
[ MyOrg:1_HAAS3 ] [ Current Scenario:Forecast ] [ Current Stage:Working ][ Current Year of View:FY15 ] [ Refresh ]
D2 - f-| 46XXX - Sales Services & Other Income - Plan
A B C D u — | Smart Viev
+YearTotal |8
earfota Task List
1 Server;
2 Sales and Services Educational - Plan C1- Summary - Plan |46XXX—SaIEs Services & Other Income - Plan 141,360 Aoplica
1_10187 - BAHSB Devel Alumni Relations v B CalPlan Fy
3~ Restricted Gifts - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 151,125
4 Restricted Gifts - Plan C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 476,262 -0
1_10650 - BAHSE Student Aid FTMBA . v . . : o2
5 Restricted Endowments and FFEs - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 258,000 E o 3‘[
=l | = 3
6 1 10651- BAHSB Student Aid SelfSupp MBA  Restricted Endowments and FFEs - Plan C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 175,750 B O 40
7 |1 10208 - BAHSB Berk Innov Ldr Dev-BILD Restricted Gifts - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 43,875 e}
8 Sales and Services Educational - Plan C1- Summary - Plan |46XXX - Sales Services & Other Income - Plan 139,500 c
9 110314 - BAHSB Instr MFE Gen Ops Restricted Gifts - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 9,750 g
10 Restricted Endowments and FFEs - Plan C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 54,000 c
11 |1_10249 - BAHSB Instr MBA Gen Ops Sales and Services Educational - Plan C1- Summary - Plan |46XXX - Sales Services & Other Income - Plan 3,943 B O 5.1
12 |1_10250 - BAHSB Instr MBA S5 Wkshp Sales and Services Educational - Plan C1-Summary - Plan |46XXX - Sales Services & Other Income - Plan 60,450/ |7
13 110286 - BAHSS Instr UG Gen Ops Sales and Services Educational - Plan C1- Summary - Plan |46XXX - Sales Services & Other Income - Plan 6,984
4|~ Restricted Gifts - Plan C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 1,200
15 |1_10545 - BAHSB Acad Visiting Schols Sales and Services Educational - Plan C1- Summary - Plan |46XXX - Sales Services & Other Income - Plan 33,852
16 |1 10196 - BAHSB Devel Annual Giving Restricted Gifts - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 3,753,750
17 |1_10521- BAHSB Endow Chr & Disting Prof  Restricted Endowments and FFEs - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 2,315,048
18 Sales and Services Educational - Plan C1-Summary - Plan |46XXX - Sales Services & Other Income - Plan 10,230
19 1 10582 - BAHSB Prov General 60351 - Center for Exec Education C1- Summary - Plan |46XXX - Sales Services & Other Income - Plan 5,000,000
20| ~ Restricted Gifts - Plan C1- Summary - Plan |440XX - Private Gifts for Current Use - Plan 1,590,509
21 Restricted Endowments and FFEs - Plan C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 1,091,297
22 20150 - EVENING MBA-HAAS FEE C1-Summary - Plan |4055X - Self-Supporting Degree Program - Plan | 25,273,384 4 [om
23 20151 - MFE Degree Fee C1- Summary - Plan |4055X - Self-Supporting Degree Program - Plan 3,626,223 Open F
24 20152 - MBA Application F C1-8§ - Pl 401XX- Application F -Pl 467,200 Mark C
110584 - BAHSB Student Fee Revenue pplication Fee ummary - Fian ppiication Fees - Flan Task Det
5|~ 20154 - Berkeley Exec MBA Degree Fee C1- Summary - Plan |4055X - Self-Supporting Degree Program - Plan | 8,560,186 ——
26 20231- PD Supp Tuition - Bus Adm/Mgmt  C1- Summary - Plan 4053X - Professional Degree Fees - Plan 21,470,950 Task List
27 20266 - HAAS Summer Fees C1- Summary - Plan |4055X - Self-Suppaorting Degree Program - Plan 192,000 20
28 1_10335. BCHCI Enargy 8 Envir lnnaw Cir Restr?cted Gifts - Plén C1-Summary - Plan |440XX - Private Gifts for Current Use - Plan 156,000 L m
W 4 » ¥ | Intersection Form by Entity -~1 Intersection Form by Entity -~2 Intersection Form by Entity -~3 Intersection Form by Entity -~4 Intersection Form by Entity -[I] 4 il » [
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CalPlanning | Job Aid Enter Data into Intersection Forms

8. Add an intersection row into the form in Smart View by right-clicking anywhere in the form. Navigate to Smart View ->
Add Intersection by [Account]
i S0
i 20
1 4
] smart View * | [B] Expand/Collapse

Jegree Program - Plan | 25,273,3 &, Drill-through
Jegree Program - Plan 3,626,2 o=

- Plan 467,2 ’ |
Jegree Program - Plan #.560.1

Options...

Add Intersection by Revenue

9. The “Launch Business Rule” window appears. Fill in the fields as necessary and click OK. Be sure to select the lowest level
members in each field. Otherwise, the business rule will not create a new intersection.

£ |

Launch Business Rule

Plan Type
CalPlan

Business Rule Flan Type Type
AddIntersection-Revenue CalPlan Rule

Run Time Prompts

st

------ Select the lowest level Fund (g.g. 19900]

"Sales_Services_Educ_Plan”™ |
ad

------ Select the lowest level Revenue Account (eg. 41010)

) "A41010" |

% Select lowest level Chartl {eg. C1_SUMPLN)

"C1_SUMPLN" |
st

=5 Select the lowest level Dept ID (eq. 1_11871)

"1 10187 |

CK ] [ Cancel
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CalPlanning | Job Aid Enter Data into Intersection Forms

10. The intersection for will add a new row with $SO.

POV Intersection Form by Entity - HYPP-PA0S_CalPlan_1

[ MyOrg: 1_HAAS3 ] [ Current Scenario:Forecast ] [ Current Stage:Working ] [ Current Year of View:FY 15 ] [ Refresh ]

D6 - fe | 440XX - Private Gifts for Current Use - Plan
A B c D U

+YearTotal

1

2 41010 - State G IS rt 1]

. ) Sales and Services Educational - Plan C1- Summary - Plan ate bheneral suppo

3 |1_10187 - BAHSB Devel Alumni Relations 46X XX - Sales Services & Other Income - Plan 141,360

4 Restricted Gifts - Plan C1- Summary - Plan [440XX - Private Gifts for Current Use - Plan 151,125

5 110650 - BAHSE Student Aid FTMBA Restr!cted Gifts - Plan C1- Summary - Plan |440XX - Pr!vate G!fts for Current Use - Plan 476,262

6 Restricted Endowments and FFEs - Plan C1- Summary - Plan 440XX - Private Gifts for Current Use - Plan 258,000

1 AACET BANER Chadant AZd Calffiinn AANA | Aackcictad Fadomnnde aed FEF- Alan A1 Peimne Alan | AAAVY Peiiedn AiFe fae Peaenod Hen Alan a7 wcn

11. Update the amount in the new intersection row. You may notice a color change on the edited cell, which means that the
data has been entered into the form but has not been saved yet. Select Submit Data.

Book2 - Microsoft Excel
Formulas Data Review View Developer Smart View Planning Acrobat
* [65] Adjust ~ %T Mare * -dj Approvals
N, Drill-through
ER submit Data

&3 Copy Version

Workflow

Unlike CalPlan, there is no confirmation that the data is saved and that the AggEntity business rule is run
successfully. If the data has been saved and the AggEntity business rule is run successfully, the color of the cell
should revert back to the same color as the rest of the data values.

To confirm the update was successful, refresh the page by clicking on the Refresh button:

Il—-“ H9- M-l Book3 - Microsoft Excel
“ Home Insert Page Layout Formulas Data Review View Developer Smart View Planning Acrobat
JE @ | B cell Actions ~ @3 Adjust - El Mare - BE Approvals
g | .E, Lock '.‘_, Drill-through &3 Copy Version
Analyze|| Refresh POV |
= B calculate - ER submit Data
Ad Hoc Data Waorkflow
POV Intersection Fc& Tabs - hypp-qal6_CalPlan_2

[Myorg:l_HAAS3 || Curr&_t Scenario:Forecast ] [ Current Stage:Working ] ‘ Current Year of View:FY14 || Refresh |
N\

w22 XN %]

A B C D U
10 1 10653 - BAHSE Student Ald Undergrad Restricted Regents Endowments - Plan C1-Summary - Plan 72210 - Regents Endow/FFE Payout 2964
T Restricted Regents FFE- Plan C1-Summary-Plan 72210 - Regents Endow//FFE Payout 15036

You have successfully added an intersection row into an Intersection Form using Smart View.
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